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ABSTRAK 

 

Tujuan penelitian ini adalah untuk mengetahui keanekaragaman flora 

terutama jenis pohon ulin (E. zwageri), mengetahui potensi pohon ulin di plot 

penelitian dan memetakan kehadiran sebaran pohon ulin di plot penelitian tersebut 

sehingga menjadi dasar bagi pengelola KRUS dalam melaksanakan kebijakan.  

Objek penelitian di plot penelitian dengan metode jalur di KRUS.  Transek 

dibuat masing-masing sepanjang ± 1.000 m, lebar 20 m, yang dimulai dengan 

mengambil titik awal.  Data yang dikumpulkan adalah data primer berupa 

inventarisasi ulin pada tingkat tiang dan pohon yaitu yang berdiameter batang           

≥ 10 cm.  Data yang diambil meliputi jumlah individu, diameter batang pohon, 

tinggi bebas cabang dan tinggi total pohon, sedangkan data skunder diperoleh 

langsung dari hasil penelitian sebelumnya, literatur-literatur, laporan-laporan dan  

tulisan dari pihak instansi yang terkait yang mencakup letak daerah, kondisi tanah, 

kondisi geogarafi, iklim, curah hujan dan vegetasi. Serta metode wawancara 

digunakan untuk memperoleh data dan informasi dari petugas di lapangan, pejabat 

instansi terkait dan penduduk setempat yang ada hubungannya dengan kegiatan 

penelitian dan dari berbagai literatur yang mendukung. 

Hasil penelitian yang diperoleh adalah 1) Diameter pohon Ulin yang 

paling besar adalah 86,1 cm dengan volume total sebesar 8,31 m³ yang ditemukan 

pada transek A sedangkan diameter yang paling kecil adalah 11,3 cm dengan 

volume total sebesar 0,04 m³ yang ditemukan pada transek C. Adapun potensi 

pohon Ulin dapat dilihat dari jumlah volume tinggi bebas cabang pohon Ulin yang 

ditemukan di lokasi pengamatan seluas 6 Ha adalah sebesar 27,65 m³ sedangkan 

volume total adalah sebesar 55,86 m³; 2) Sebaran pohon Ulin di KRUS paling 

banyak ditemukan pada zona konservasi seluas 3,48 Ha sebanyak 11 pohon, pada 

zona koleksi/pengayaan sepanjang 2,24 Ha seluas 10 pohon dan pada zona 

rekreasi seluas 0,28 Ha sebanyak 8 pohon. 

Saran yang disampaikan dari hasil penelitian ini adalah 1) Agar pihak 

KRUS berusaha tetap menjaga keberadaan dan kelestarian pohon Ulin yang sudah 

ada di KRUS dari gangguan kebakaran hutan; 2) Perlu dilakukan inventarisasi 

pohon Ulin pada seluruh kawasan KRUS ntuk mengetahui sebaran dan potensi 

pohon Ulin dan 3) Perlu dilaksanakan penanaman pohon Ulin untuk 

meningkatkan jumlah keberadaan pohon Ulin di KRUS dan juga menjaga dan 

mengurus anakan-anakan pohon Ulin yang masih ada. 
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I. PENDAHULUAN 

A. Latar Belakang 

Hutan Indonesia memiliki keanekaragaman hayati yang tergolong kaya 

(Megabiodiversitas) setelah Brazil dan Columbia (Mc. Neely, 1990 dalam Ahmad 

Munawir, 1997).  Sebagai konsekuensinya Indonesia memiliki tantangan untuk 

memelihara kekayaan sumber daya hayati tersebut dan mengembangkan 

peranannya bagi pembangunan yang pada saat ini Indonesia masih bertumpu 

kepada pemanfaatan kekayaan sumber daya alam yang dimilikinya.  

Keanekaragaman tumbuh-tumbuhan yang besar di hutan hujan tropis di 

kawasan Malesiana ditinjau dari sudut ekologi dan niaga, di mana yang 

terpenting adalah kehadiran hutan Dipterocarpa (umumnya dataran rendah) 

ialah jenis-jenis dari suku Dipterocarpaceae seperti Dipterocarpus spp., 

Hopea spp., serta Dryobalanops spp.  (Withmore, 1975). 

Ulin merupakan salah satu pohon hutan Kalimantan yang langka karena 

memiliki banyak manfaat.  Pada umumnya masyarakat hanya mengenal manfaat 

Ulin dari pemanfaatan kayunya yang memiliki nilai ekonomi sangat tinggi.  

Manfaat pohon Ulin antara lain manfaat ekonomi, ekologi dan sosial budaya. 

Kepunahan pohon Ulin semakin jelas dan nyata, hal ini dikarenakan 

eksploitasi penebangan kayu yang kurang terkontrol dimasa lalu sampai sekarang 

serta disebabkan pula adanya kebakaran hutan, sehingga menyebabkan 

populasinya menurun drastis.  Apalagi Ulin berkembang sangat lambat, karena 

perkembangannya yang tergolong lambat inilah jarang sekali ada masyarakat yang 

mengembangkannya dan kalaupun ada hanya sebagai tanaman sampingan dari 
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lahan kosong mereka.  Tumbuhan langka ini seharusnya dilindungi dan dirawat 

dengan baik agar populasinya semakin hari semakin tidak menurun. 

Inventarisasi pohon Ulin (Eusideroxylon zwageri Teijsm. & Binn.) di 

Kebun Raya Unmul Samarinda (KRUS) perlu dilakukan untuk mengetahui 

seberapa banyak pohon Ulin masih bisa ditemukan di KRUS.  Pemberian 

informasi diharapkan dapat menjadi bahan pertimbangan dalam pengelolaan 

kawasan KRUS. 

B. Tujuan Penelitian 

Penelitian ini bertujuan untuk mengetahui keanekaragaman flora terutama jenis 

pohon Ulin (Eusideroxylon zwageri) adalah sebagai berikut: 

1. Untuk mengetahui potensi pohon Ulin di plot penelitian di Kebun Raya 

Unmul Samarinda (KRUS); 

2. Untuk memetakan kehadiran sebaran pohon Ulin di plot penelitian tersebut 

sehingga menjadi dasar bagi pengelola KRUS dalam melaksanakan 

kebijakan. 

 
C. Manfaat Penelitian 

Adapun manfaat dari penelitian ini adalah dapat memberikan informasi mengenai 

profil serta keberadaan pohon Ulin yang tumbuh pada KRUS sehingga dapat 

dijadikan sebagai dasar pertimbangan dalam pengelolaan selanjutnya. 
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II. TINJAUAN PUSTAKA 

A. Keanekaragaman Jenis Hutan Hujan Tropis Kalimantan Timur 

Berdasarkan Surat Keputusan Menteri Kehutanan Provinsi Kalimantan Timur 

Nomor: 79/Kpts-II/2001 tanggal 15 Maret 2001 bahwa luas wilayah provinsi 

Kalimantan Timur 14.651.553 Ha dengan jumlah Kawasan Hutan Konservasi 

2.165.198 Ha ( 173.272 Ha Hutan Cagar Alam, 1.930.076 Ha Hutan Taman 

Nasional dan 61.850 Ha Hutan Wisata Alam), 2.751.702 Ha Hutan Lindung, 

4.612.965 Ha Hutan Produksi Terbatas dan 5.121.688 Ha Hutan Produksi.  

Wilayah floristik di wilayah Kalimantan Timur termasuk dalam kawasan 

fitogeografi Malesia yang terkenal keanekaragaman yang tinggi. Wilayah 

Indonesia mempunyai jenis flora dan fauna yang dikenal sebanyak 325.000 jenis. 

Hutan hujan tropis di wilayah Kalimantan Timur dikenal dengan dominasi dari 

jenis-jenis suku Dipterocarpaceae. Sekitar 500 jenis dari suku Dipterocarpaceae di 

dunia terdapat 284 jenis dari 10 genus Kalimantan Timur.  Beberapa ahli 

menyebutkan bahwa famili ini berasal dari daratan Kalimantan, kemudian terbukti 

bahwa jumlah jenis Dipterocarpaceae semakin berkurang (Sumarsono, 1997 

dalam Limbong, 2002). 

 
B. Inventarisasi Hutan 

Inventarisasi Hutan adalah kegiatan pengumpulan dan penyusunan data 

dan fakta mengenai sumber daya hutan untuk perencanaan pengelolaan sumber 

daya tersebut (Anonim
d
, 2013). 

Tujuan inventarisasi hutan adalah untuk mendapatkan data yang akan 

diolah menjadi informasi yang dipergunakan sebagai bahan perencanaan dan 

perumusan kebijaksanaan strategik jangka panjang, jangka menengah dan 

operasional jangka pendek sesuai dengan tingkatan dan kerjalaman inventarisasi 

yang dilaksanakan (Anonim
d
, 2013). 

 
C. Risalah Umum Pohon Ulin (Eusideroxylon zwageri Teijsm. & Binn.) 

1. Aspek Ekologis 

Menurut Keβler dan Sidiyasa (1999) dalam Edi (2012), Ulin (E. zwageri) 

biasa tumbuh dalam hutan primer dan sekunder lahan pamah, hingga ketinggian 

500 meter, di tanah berpasir dan berdrainase baik, sering dijumpai sepanjang 

aliran sungai dan bukit-bukit didekatnya, kadang-kadang membentuk tegakan 

murni.   

Persyaratan tumbuhnya pohon Ulin di daerah yang memiliki curah hujan 

dengan tipe iklim A dan B (Schmith & Ferguson, 1951 dalam Anonim
b
, 2010) 

dengan intensitas curah hujan 2.500 mm – 4.000 mm/th dengan ketinggian tempat 

5 – 400 m diatas permukaan laut (dpl).  Jenis ini dapat tumbuh ditanah berpasir 

atau tanah liat. Hasil Penelitian Nugroho (2010) dalam Anonim
b
 (2010) Ulin 
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mampu tumbuh pada tanah yang tingkat kesuburannya rendah (pH, KTK, KB, N, 

P, K, C/N, K, Ca, Mg, Na rendah dan kandungan Al yang tinggi). 

Ulin biasanya tumbuh secara menyebar atau mengelompok dengan kanopi 

dominan dan juga ditemui sebagai tegakan tersendiri. Ulin biasanya ditemukan 

berasosiasi dengan jenis-jenis koompasia, shorea dan intsia (Hakim dan 

Prastyono, 2005 dalam Anonim
b
, 2010).  

2. Aspek Botani 

a. Pohon 

Pohon Ulin (Eusideroxylon zwageri) dewasa dapat mencapai tinggi total 

hingga 40 meter dengan tinggi bebas cabang antara 15 - 21 meter, dan garis 

tengah atau diameter mencapai ± 80 cm.  Biasanya berbatang lurus, tidak berbanir 

(Keβler dan Sidiyasa, 1999 dalam Edi, 2012).  

b. Kulit 

Pepagan halus, agak mengeripih, coklat kemerah-merahan.  Kulit luar 

mempunyai ketebalan antara 2 – 9 mm (Keβler dan Sidiyasa, 1999 dalam Edi, 

2012).  

c. Tajuk dan Daun 

Bentuk tajuk Ulin biasanya hampir bulat, cabang-cabang besar tidak 

banyak, ranting-ranting kecil seringkali agak menggantung membentuk rapat  

Daun Ulin mempunyai tangkai daun sepanjang ± 1 cm, berbentuk 

melonjong bundar telur dan menjorong, dengan ujung runcing hingga melancip 

dan pangkalnya membundar, lebar antara 6 – 9 (-15) cm dengan panjang 20 – 30 

cm, dan tulang daun sekunder terdapat 8 - 12 pasang, letak daun berselang seling 

teratur dan tidak mempunyai daun penumpu (stipula).  Permukaan daun sebelah 

atas mengkilat halus dan pada bagian bawahnya terdapat tulang daun yang 

berbulu halus.  Pada waktu daun muda berwarna merah dan setelah tua berwarna 

hijau mengkilap (Sidiyasa dan Juliaty, 2003 dalam Edi, 2012). 

d. Bunga  

Bunga memalai pada ketiak daun, berkelamin ganda, tabung, tajuk pendek, 

bercuping 6 hampir sama, benang sari 12, benang sari semu ada, bakal buah 

membulat.  Bunga Ulin berwarna kuning kehijauan serta berukuran sangat kecil 

dengan diameter 1 mm.  Panjang tangkai 10 – 20 cm dan berbulu halus (Sidiyasa 

dan Juliaty, 2003 dalam Edi, 2012). 

e. Buah 

Buah melonjong, menyelinder, panjang hingga 15 cm, garis tengah hingga 8 cm.  

Buah Ulin memiliki ukuran yang tidak sama besar dengan ujung-ujungnya yang 

lancip atau tumpul, bentuk buah berbeda-beda ada yang panjang dan ada yang 

tipis serta runcing.  Buah berbiji satu dan kulit luarnya licin pada waktu muda 

berwarna hijau dan setelah tua berwarna merah sampai kehitaman. Biji Ulin 
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berada dalam buah (arillus) dan kulit biji sangat keras seperti batu (Sidiyasa dan 

Juliaty, 2003 dalam Edi, 2012). 

3. Kegunaan 

Kayu Ulin dikenal sangat keras dan mempunyai keawetan alami yang 

tinggi sehingga banyak dimanfaatkan untuk bahan konstruksi pada berbagai 

bangunan baik di darat maupun di daerah berair karena kayu jenis ini tahan 

terhadap pelapukan dan tahan dari gangguan serangan rayap (Yusliansyah, 2004 

dalam Edi, 2012). 

Kayu Ulin termasuk pohon yang berdaun sepanjang musim. Ketahanan 

kayu yang merupakan kelas awet 1 dan kelas kuat 1 sejak dahulu sangat diminati 

untuk bahan kontruksi terutama pada daerah yang terendam air (jembatan, 

dermaga), selain itu dipakai sebagai papan, sirap dan bagian bangunan lainnya 

(Balitbang Kehutanan Samarinda, 2004 dalam Anonim
b
, 2010). 

Disamping kayunya bagian lainnya seperti daunnya berkhasiat obat 

dimana daun mudanya dihaluskan dan diambil ekstraknya untuk menyuburkan 

rambut.  Selanjutnya buah Ulin yang besar dan keras bersifat racun, serta 

dimanfaatkan sebagai obat melawan pembengkakan setelah dipotong kecil untuk 

dioleskan.  Tunggak dan akar dapat digunakan sebagai bahan kerajinan untuk 

pembuatan mebel (Heyne, 1987 dalam Edi, 2012).   

4. Penyebaran 

Penyebaran jenis pohon Ulin meliputi pulau Sumatera yaitu provinsi Jambi, 

Sumatera Selatan, Bangka Belitung dan Pulau Kalimantan. Di luar Indonesia 

pohon Ulin dapat ditemukan pula di Malaysia (Serawak, Semenanjung Malaysia, 

Sabah dan Brunei Darussalam), Kepulauan Sulu dan Philipina (Pulau Palawan) 

(Fakhrurazi, 2009 dalam Anonim
b
, 2010). 

5. Regenerasi 

Regenerasi alami biasanya terbatas pada areal dekat pohon induknya.  Anakan 

Ulin yang terdapat di hutan tropis yang tertutup oleh kanopi biasanya dapat 

bertahan  hidup dan jarang mati.  Regenerasi anakan Ulin sangat rendah pada 

hutan bekas tebangan, sehingga diperlukan campur tangan manusia untuk 

melakukan permudaan buatan.  Keterbatasan jumlah biji Ulin menyebabkan biaya 

penanaman yang mahal dan pembuatan bibit melalui metode kultur jaringan 

dianjurkan.  Pohon Ulin terdapat di hutan dataran rendah (Hakim dan Prastyono, 

2005 dalam Anonim
b
, 2010).  

Maika dalam Anonim
b
 (2010), biji Ulin memerlukan waktu yang lama kadang-

kadang sampai satu tahun untuk berkecambah.  Ada dua macam kesulitan yang 

timbul untuk permudaan jenis Ulin.  Pertama, bagaimana mendapatkan tanaman 

yang tumbuh secara bersamaan dengan biji-biji yang berkecambah sangat lambat 

dan tidak teratur.  Kedua, bagaimana menjamin naungan yang diperlukan pada 

proses perkecambahan dan pertumbuhan awal dan seterusnya (Maika dalam 

Anonim
b
, 2010). 

6. Status Konservasi 
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Ulin merupakan salah satu jenis yang hampir punah sebagai akibat dari tingginya 

laju penebangan yang dilakukan secara legal maupun illegal oleh masyarakat 

maupun perusahaan pemegang HPH.  Menurut Soerianegara dan Lemmens (1993) 

dalam dalam Anonim
b
 (2010), jenis ini telah terancam punah.  Sedang 

berdasarkan data IUCN (2000) dalam Anonim
b
 (2010), jenis ini dikategorikan 

dalam kelompok yang rentan (vulnerable) yaitu populasi mengalami penurunan 

lebih dari 20% selama 10 tahun.  Penyebab utama keterancaman kepunahan 

adalah karena kerusakan habitat dan pemanfaatan yang tidak terkendali (Nugroho, 

2010 dalam dalam Anonim
b
 , 2010). 

7. Strategi Konservasi Sumberdaya Genetik Ulin 

Strategi konservasi keragaman genetik Ulin dapat dirancang berdasarkan hasil 

penelitian yang telah dilakukan oleh Rimbawanto, et. al (2006) dan Irawan (2005) 

dalam Anonim
b
 (2010) masing-masing provinsi dapat dianggap sebagai satu 

populasi besar, sehingga eksplorasi materi genetik Ulin dalam rangka konservasi 

sumberdaya genetik dilakukan di tiap provinsi. 

Kegiatan perlindungan, pengawetan, dan pemanfaatan dilaksanakan dalam tiga 

level yang terdiri dari level genetik, jenis, dan ekosistem.  Kegiatan konservasi 

antara lain bertujuan untuk mencegah terjadinya penurunan keanekaragaman dan 

kepunahan di tiga level tersebut. Menurut Nugroho (2010) dalam Anonim
b
 

(2010), strategi konservasi in-situ maupun ex-situ Ulin idealnya saling 

komplementer.  Konservasi ex-situ merupakan cadangan bagi konservasi in-situ.  

Konservasi ex-situ berfungsi untuk mendukung jenis target yang mungkin hilang 

berbagai sebab di areal konservasi in-situ.  Konservasi ex-situ harus 

memperhatikan syarat-syarat tempat tumbuh (tanah) yang sesuai di mana Ulin 

tumbuh pada sebaran alaminya. 

Menurut Siregar (2008) dalam Anonim
b
 (2010) metode konservasi sumberdaya 

genetik yang dilakukan adalah konservasi in-situ dinamis dan konservasi ex-situ 

dinamis.  Konservasi in-situ dinamis dengan penanaman pengayaan bahan 

tanaman setempat pada hutan alam atau tempat tumbuhnya.  Konservasi ex-situ 

dinamis yaitu program pemuliaan dengan membuat tegakan benih provenans 

(asal/sumber) dan tegakan konservasi genetik.  

Upaya konservasi ex-situ sudah dilakukan oleh berbagai pihak, misalnya sejak 

1997 masyarakat Desa Tanjung Harapan Kalimantan Timur menanam tanaman 

Ulin sebagai naungan pada tanaman kopi. PT Kiani Hutani Lestari, sejak tahun 

1995-1997 pada batas petak dan jalur hijau sepanjang sungai. Pada tahun 2003 

Balai Litbang kehutanan bekerjasama dengan PT. KEM telah menanam Ulin 

seluas 10 Ha (Balitbang Kehutanan Samarinda, 2004 dalam Anonim
b
, 2010). 

Kegiatan pembangunan plot konservasi ex-situ Ulin juga dilakukan di Hutan 

Penelitian Sumberwringin, Bondowoso, Jawa Timur sejak Desember 2004 

(Hakim dan Prastyono, 2005 dalam Anonim
b
, 2010). 

Demikian halnya konservasi in-situ juga telah diupayakan oleh Pemerintah 

Kalimantan Timur melaui SK. Kepala Dinas Kehutanan 522.21/005.79/DK-

V/1991 tanggal 20 agustus 1981, dimana setiap HPH diwajibkan menunjuk 

tegakan pohon induk jenis Ulin dengan luas minimal 100 Ha (Balitbang 

Kehutanan Samarinda, 2004 dalam Anonim
b
, 2010). 
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8. Klasifikasi Ulin 

Klasifikasi Ulin (Eusideroxylon zwageri Teijsm. & Binn.) berdasarkan 

ilmu Taksonomi Tumbuhan adalah (Tjitrosoepomo, 2007 dalam Edi, 2012): 

Kerajaan : Plantae 

Divisi : Spermatophyta 

Subdivisi : Angiospermae 

Kelas : Dicotyledonae 

Subkelas : Dyalypetalae 

Ordo : Ranales 

Suku : Lauraceae 

Marga : Eusideroxylon 

Jenis/Species : Eusideroxylon zwageri Teijsm. & Binn. 

 

 

 

 

 

 

 
D. Pemetaan 

Peta adalah suatu gambaran dari unsur-unsur alam dan atau buatan 

manusia, yang berada di atas maupun di bawah permukaan bumi yang 

digambarkan pada suatu bidang datar dengan skala tertentu (Anonim, 2004). 

Pemetaan adalah proses pengukuran, perhitungan dan penggambaran 

permukaan bumi (terminologi geodesi) dengan menggunakan cara dan atau 

metode tertentu sehingga didapatkan hasil berupa softcopy maupun hardcopy peta 

yang berbentuk vektor maupun raster (Anonim
a
, 2013) 

Sedangkan Anonim
b
 (2013) pemetaan adalah proses pengukuran, 

perhitungan dan penggambaran permukaan bumi dengan  menggunakan cara atau 

metode tertentu sehingga didapatkan hasil berupa softcopy dan hardcopy. Adapun 

proses Pengumpulan Data  dilakukan dengan: 

a. Pengukuran langsung di Lapangan dengan menggunakan alat sederhana yaitu 

Kompas dan pita ukur serta alat optik seperti Theodolit. 

b. Penyadapan data dari Penginderaan jauh berupa foto udara maupun Citra 

Foto yang digunakan untuk peta tematik dan peta umum. 

c. Pengumpulan data statistik hasil sensus maupun data  tabel 

d. Penggunaan peta yang sudah ada  juga atlas 
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GPS adalah suatu alat dengan sistem satelit navigasi yang dapat digunakan 

untuk menentukan posisi titik dengan cara melakukan pengamatan terhadap 

beberapa satelit  GIS (yang beredar pada orbitnya) sebagai sumber transmitter 

gelombang mikro, gelombang ini membawa isyarat-isyarat navigasi yang 

dibutuhkan oleh pengamat melalui bantuan receiver (Anonim
b
, 2012). 

Koordinat geografis adalah suatu besaran untuk menyatakan letak atau 

posisi bujur dan lintang suatu titik di lapangan secara relatif terhadap sistem 

referensi tertentu (Anonim
b
, 2012). 

Mapsource adalah software yang didapat ketika kita membeli produk GPS 

Garmin.  Namun Mapsource dapat digunakan sebagai alternatif untuk 

menampilkan peta digital Indonesia, yang dapat diperoleh secara gratis (Anonim
c
, 

2013).  Mapsource adalah software atau program yang digunakan untuk 

mentransfer data-data terekam pada GPS seperti titik koordinat, tracking 

(penggambaran secara langsung posisi arah kemana kita pergi disuatu tempat) 

(Anonim
a
, 2012). 

Global Mapper adalah salah satu perangkat lunak yang cukup populer 

sering digunakan oleh kalangan praktisi GIS (Geographics Information System) 

atau orang-orang yang berkecimpung di bidang pemetaan. Salah satu 

keistimewaan program ini adalah kompatibilitasnya dengan banyak sekali format 

file (Anonim
b
, 2011). 

ArcGIS adalah salah satu software yang dikembangkan oleh ESRI 

(Environment Science & Research Institute) yang merupakan kompilasi fungsi-

fungsi dari berbagai macam software GIS yang berbeda seperti desktop, server 

dan GIS berbasis web.  ArcMap merupakan aplikasi utama yang digunakan dalam 

ArcGis yang digunakan untuk mengolah/membuat (create), menampilkan 

(viewing), memilih (query), editing, composing dan publishing peta (Anonim
d
, 

2012). 
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III.  METODE PENELITIAN 

A. Tempat dan Waktu Penelitian 

1. Tempat 

Penelitian ini dilaksanakan kawasan Kebun Raya Unmul Samarinda 

(KRUS), Kelurahan Tanah Merah Kecamatan Samarinda Utara Provinsi 

Kalimantan Timur.      

2. Waktu Penelitian 

Penelitian dilakukan selama ± 3 bulan, terhitung sejak Maret s/d Mei 2014.  

Meliputi kegiatan orientasi lapangan, studi literatur, pengumpulan data sekunder 

dan di lapangan, serta penyusunan skripsi.  

Tabel 1. Uraian Kegiatan Penelitian 

NNo

. 
Uraian 

Waktu 

Pebruari 

2014 

Maret 

2014 

April 

2014 

Mei 

2014 

III IV I II III IV I II III IV I II 

11 

Usulan Proposal 

Skripsi dan 

Persetujuan Seminar 

Proposal. 

            

22 

Penelitian, 

Penyusunan Skripsi 

dan Seminar Hasil 

Penelitian 

            

3 

Persiapan Ujian 

Pendadaran dan 

Revisi 

            

4 
Ujian Pendadaran 

serta Hasil Akhir. 

            

 

 

 

B. Bahan dan Alat Penelitian 

1. Bahan 

Bahan atau obyek penelitian adalah tumbuhan (flora) khususnya pohon Ulin 

(Eusideroxylon zwageri) dan dijumpai di plot ukur dan peta KRUS dan peta lokasi 

penelitian.  

2. Alat 
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Sedangkan alat yang digunakan dalam penelitian ini terdiri dari : 

a. phiband untuk mengukur diameter; 

b. clinometer untuk mengukur tinggi pohon; 

c. tali tambang yang sudah diberikan ukuran panjang untuk mengukur plot 

penelitian; 

d. pita tanda jalur (flagging tape) dengan warna kuning untuk memberi tanda 

jalur dan warna merah untuk menandakan posisi pohon 

e. kompas merk Shunto untuk menentukan arah mata angin; 

f. parang untuk merintis jalan; 

g. GPS untuk mengambil titik koordinat obyek penelitian; 

h. pita dan cat untuk menandai obyek penelitian yang sudah diukur; 

i. kamera digital untuk dokumentasi;  

j. tallysheet dan alat tulis; 

k. komputer untuk penulisan data-data; 

l. perangkat lunak Arc Gis untuk membuat Peta Sebaran Ulin di plot penelitian. 

 

C. Prosedur Penelitian 

1. Studi Literatur 

Studi literatur adalah kegiatan mempelajari teori yang relevan dengan judul 

penelitian dan mengumpulkan data-data sekunder yang diperlukan untuk kegiatan, 

berupa data dari hasil penelitian yang telah dilakukan, keterangan-keterangan 

lisan maupun masukkan dari beberapa sumber dan dosen pembimbing. 
2. Orientasi Lapangan 

Orientasi lapangan ini digunakan untuk mengumpulkan data primer di lapangan, 

data yang dikumpulkan meliputi keadaan fisik lapangan untuk mengetahui situasi 

dan kondisi di lapangan serta pembuatan transek sehingga pelaksanaan penelitian 

(pengumpulan data) dapat lebih terjamin keberhasilannya.  
3. Inventarisasi Flora 
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Pada penelitian ini digunakan metode transek dengan cara menetapkan garis 

transek dengan arah memotong garis kontur dengan panjang transek 1.000 m dan 

lebar 20 m yang dimulai dengan mengambil titik awal seperti Gambar 1. dibawah 

ini. 

 

 

 

 
 

              

 

 

 

 

 

 

Gambar 1. Bentuk Metode Transek 

Pada setiap transek diberi tanda dengan flagging tape agar mempermudah 

pekerjaan pengamatan dan dihitung jumlah individu, dimulai dari jenis sampai 

tingkat pohon yang diukur keliling atau diameter serta tinggi vegetasi tiang dan 

pohon. Koordinat transek yang dibuat pada lokasi penelitian dan titik koordinat 

pohon yang diteliti, diambil dengan menggunakan GPS (Global Position System). 

 

D. Pengamatan dan Pengumpulan Data 

1. Data Primer 

Parameter yang dicatat dan diukur adalah jumlah individu, diameter batang 

pohon, tinggi bebas cabang pohon, tinggi total pohon Ulin pada tingkat tiang dan 

pohon yaitu yang berdiameter  ≥ 10 cm dan titik koordinat pohon dengan 

menggunakan GPS.   
2. Data Sekunder 

Data sekunder mencakup risalah daerah penelitian yang didapatkan dari hasil 

penelitian sebelumnya, literatur-literatur, laporan-laporan dan  tulisan dari pihak 

instansi yang terkait yang mencakup letak daerah, kondisi tanah, kondisi 

geogarafi, iklim, curah hujan dan vegetasi.  Serta metode wawancara digunakan 

untuk memperoleh data dan informasi dari petugas di lapangan, pejabat instansi 

terkait dan penduduk setempat yang ada hubungannya dengan kegiatan penelitian. 

 

 

 

 

 

 

 

 

Arah Rintis 

20 m 

20 m 

10 m 

10 m 
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E. Analisa Data 

1. Pengolahan Data 

Hasil pengukuran kemudian diolah dalam bentuk tabel dan grafik, sehingga dapat 

diketahui jumlah individu, diameter batang, tinggi bebas cabang (TBC), tinggi 

total (T tot), volume bebas cabang (V BC) dan volume total          (V Tot).  

Adapun rumus-rumus yang digunakan untuk mengetahui beberapa parameter 

yang berhubungan dengan pengolahan data adalah : 

a. Jumlah Individu 

Jumlah individu adalah total dari individu-individu yang terdapat di lokasi 

penelitian. 

b. Diameter Batang 

Diameter batang pohon Ulin (Eusideroxylon zwageri) diukur dengan 

menggunakan phiband.  Diameter batang pohon yang diukur adalah diameter 

setinggi dada dewasa, kemudian dicatat ke dalam tally sheet. 

c. Tinggi Bebas Cabang 

Tinggi bebas cabang pohon adalah tinggi dari pangkal pohon di 

permukaan tanah sampai batang bebas cabang pohon.  Cara pengukuran tinggi 

pohon sebagai berikut : 

T BC   =    L
HH

HH

basepole

basebc 



 

Keterangan :   

T BC =  Tinggi pohon 

H bc  =  Skala % clinometer pada bebas cabang 

H pole   =  Skala % clinometer pada ujung galah ukur 

H base   =  Skala % clinometer pada dasar pohon 

L          =  Panjang tongkat pembantu (panjang 4 meter) 

d. Tinggi Total Pohon 

 Tinggi total pohon adalah tinggi dari pangkal pohon di permukaan tanah sampai 

puncak pohon.  Cara pengukuran tinggi pohon sebagai berikut : 

T Tot   =    L
HH

HH

basepole

basetop





 

Keterangan :   

T Tot =  Tinggi pohon 

 H top  =  Skala % clinometer pada puncak pohon  

 H pole   =  Skala % clinometer pada ujung galah ukur 

H base   =  Skala % clinometer pada dasar pohon 

L          =  Panjang tongkat pembantu (panjang 4 meter) 
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e. Volume  

 Volume bisa juga disebut kapasitas adalah penghitungan seberapa banyak ruang 

yang bisa ditempati dalam suatu objek tersebut dalam hal ini adalah pohon.  Cara 

pengukuran volume pohon sebagai berikut : 

V   =   ¼  x π x D
2 
x T x f 

Keterangan :  

V =  Volume  D =  Diameter (cm) f  =  faktor bentuk  

 π  =  phi (22/7) T  =  Tinggi (m)  

  

 Adapun alat-alat yang digunakan di lapangan adalah sebagai berikut : 

 
Phi Band 

 
Clinometer 

 
Kompas 

   

 
GPS 

 
Pita 30 meter 

 
Pita Tanda Jalur 

(flagging tape) 
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Tali Tambang 

 
Parang 

 
 

 

Kamera Digital 

Gambar 2. Alat-alat Penelitian 

 
 

2. Analisa Data 

Semua data-data ditabulasikan pada tallysheet pengamatan yang sebelumnya telah 

dibuat kemudian di rekapitulasi.  Data-data yang sudah terkumpul melalui 

interpretasi hasil foto, pengamatan langsung, dan informasi dari pihak pengelola 

KRUS kemudian diklasifikasikan dan dianalisis secara deskriptif.  Penjelasan 

secara deskriptif akan dijelaskan penulis terpisah berdasarkan metode 

pengambilan data. 

Data yang diperoleh dari hasil pengambilan titik koordinat pohon di lapangan 

dengan menggunakan GPS selanjutnya dilakukan pemindahan data menggunakan 

program Map Source, kemudian data tersebut diolah menjadi Shapefile (Shp) 

menggunakan program Global Mapper dan dioverlaykan dalam bentuk peta 

dengan menggunakan program ArcGis.  

Pengolahan data pemetaan meliputi beberapa tahap yaitu : 

a. Download data GPS  

Data GPS yang telah diperoleh dari lapangan kemudian di download dengan 

menggunakan program Mapsource, yaitu melalui langkah-langkah sebagai 

berikut : 

 Sambungkan GPS dengan komputer yang telah terinstal program 

Mapsource dengan menggunakan kabel data Garmin 

 Setelah terhubung dan program Mapsource siap digunakan kemudian 

“Receive From Device” kemudian deteksi GPS nya kemudian beri tanda 

ceklis data GPS “Waypoint” dan “Track” (jika ada) kemudian “Ok” 
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 Maka data-data GPS yang telah di download akan muncul di layar 

program Mapsource, kemudian save dengan cara klik “File” → “Save As” 

→ beri nama filenya ditempat yang kita inginkan → pada kolom save as 

type dipilih “GPS eXchange Format (*.gpx)” → klik “Save” 

 Data GPS masih tersimpan dalam bentuk “.gpx” 

b. Merubah format vektor “.gpx” menjadi “.shp” 

Data GPS yang telah tersimpan dalam bentuk “.gpx”  kemudian diubah 

formatnya menjadi format “.shp” dengan menggunakan program Global 

Mapper, yaitu melalui langkah-langkah sebagai berikut : 

 

 Buka program Global Mapper kemudian klik tools “Open Your Own Data 

Files” kemudian buka data “.gpx” tadi kemudian “Open” 

 Kemudian akan muncul data “.gpx” pada layar Global Mapper 

 Langkah selanjutnya adalah merubah format “.gpx”  menjadi “.shp” yaitu 

klik “File” → “Export Format Vektor” → pilih format vektor yang kita 

inginkan pada “Select Export Format” yaitu format vektor “Shapefile” → 

“Ok” → kemudian muncul “Shapefile Export Options” →  klik sesuai 

dengan bentuknya, jika bentuknya adalah point makan ceklis pada kolom 

“Export Point” kemudian simpan dan diberi nama → “Ok”  

 Data GPS sudah tersimpan dalam bentuk “.shp” 

c. Memetakan / mengoverlay data  

Data GPS yang telah tersimpan dalam bentuk “.shp”  kemudian dioverlaykan 

dalam bentuk peta dengan menggunakan program ArcGis 10, yaitu melalui 

langkah-langkah sebagai berikut : 

 Panggil semua data yang akan dioverlaykan ke dalam peta yaitu dengan 

menggunakan tools “Add Data”. Pastikan semuanya sudah dalam bentuk 

“.shp”  
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 Point pohon Ulin diberi keterangan diameter untuk membedakan 

diameternya pada peta. Adapun cara memberi keterangan diameter adalah 

dengan terlebih dahulu membuat “Add Field” pada “Attribute Table” point 

pohon tersebut → “Editor” → “Start Editing” → kemudian pilih apa yang 

akan di edit → kemudian diedit dengan cara menambahkan keterangan 

diameternya pada field yang baru dibuat tadi →  “Stop Editing” →  jika 

editing telah selesai. 

 Agar Titik Koordinat berbentuk degrees minutes seconds maka pada layer 

diubah dengan cara klik kanan pada “Layer” → “Properties” → “General” 

→ “Display” pada Units diubah menjadi “Degrees Minutes Seconds” → 

“Ok” 

 Kemudian untuk mencari koordinat geografis point pohon Ulin dengan 

cara klik tools “Xtools Pro” →  “Table Operations” →   “Add X Y Z 

Coordinate” → beri ceklis pada “Add X Coordinate” dan “Add X 

Coordinate” →  pada kolom layer pilih file yang ingin diberi titik 

koordinat → klik “Specify” kemudian “Select” → “Geographic 

Coordinate System” → “World” → “WGS 1984” → “Add” → “Finish” 

→ kemudian pada kolom “Convert angular unit to” agar “DMS” nya aktif 

→ “Ok” 

 Kemudian buat layout peta. 
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IV.  HASIL PENELITIAN  

A. Gambaran Umum 

1. Letak dan Luas Kebun Raya Unmul Samarinda 

Kebun Raya Unmul Samarinda (KRUS) memiliki Luas keseluruhan 

kawasan KRUS kurang lebih 300 Ha dan berdasarkan konsep pengembangan 

kawasan dibagi ke dalam 3 zona, yaitu Zona Pengayaan Hayati 

(Koleksi/Arboretum) seluas 100 Ha, Zona Konservasi seluas 135 Ha dan Zona 

Rekreasi seluas 65 Ha (Anonim, 2008) sedangkan menurut Surat Keputusan 

Menteri Kehutanan dan Perkebunan Nomor 406/KPTS-II/1999 tanggal 14 Juni 

1999 penetapan kawasan Hutan Lempake adalah seluas 299,03 Ha.  KRUS secara 

letak geografis berada diantara 0º 25’ 10” - 0º 25’ 24“ LS dan 117º 14’ 00” - 

117º14’14“ BT yang berlokasi diantara Km.10 dan  Km.13 pada jalan poros 

Samarinda - Bontang.   

 
Gambar 3. Peta Kebun Raya Unmul Samarinda (KRUS) 

2. Iklim 

Berdasarkan klasifikasi iklim Schmidt dan Ferguson pada areal Kebun 

Raya Unmul Samarinda termasuk dalam iklim tipe A dengan nilai Q = 0 - 14,3% 

yang berasal dari perbandingan rataan bulan kering (curah hujan < 60 mm) dan 

rataan bulan basah (curah hujan > 100 mm) sehingga diperoleh nilai Q = 13,1%.   

Hal ini menunjukkan bahwa kawasan tersebut termasuk sangat basah dengan 

curah hujan relatif tinggi.  Temperatur bulanan rataan ± 26,60°C, kelembaban 

bulanan rataan ± 83,6% dan curah hujan bulanan rataan ± 161,3 mm (Anonim, 

2008). 

3. Topografi 
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Topografi KRUS bergelombang dan agak berbukit-bukit sampai datar 

dengan ketinggian 52 m - 76 m dpl, selain itu juga dapat dijumpai daerah rawa-

rawa, anak sungai dan danau (Anonim, 2008). 

4. Hidrologi 

Kawasan KRUS terdapat di bagian tengah hulu sub DAS Karang Mumus, 

kondisi seperti itu dapat mengakibatkan cabang-cabang Sungai Karang Mumus 

yang berada di dalam kawasan KRUS tersebut tidak terpengaruh oleh pasang 

surut aliran air sungai, sehingga aliran airnya terutama berasal dari curah hujan di 

kawasan tersebut yang selanjutnya mengalir ke arah selatan menuju Sungai 

Mahakam.  Mengacu pada pola jaringan saluran sungainya dan kondisi 

hidrologinya bercirikan pola percabangan pohon. 

 

 

5. Vegetasi 

Luas areal KRUS 299,03 Ha, vegetasi awal merupakan hutan alami 

Dipterocarpaceae. Setelah mengalami kebakaran pada tahun 1983, 1993, dan 1998 

vegetasi KRUS menjadi hutan sekunder muda yang mengarah ke klimaks. KRUS 

terdapat beberapa vegetasi yang tumbuh secara alami. Diantaranya terdapat 209 

jenis pohon dari 125 famili dengan 445 individu pohon per hektar. Setelah 

terjadinya kebakaran hutan yang besar pada tahun 1997/1998 yang disebabkan 

oleh kandungan batu bara yang terbakar, jenis pohon menjadi menurun menjadi 

199 jenis dan 113 famili dengan jumlah individu pohon 335 per hektar (Anonim, 

1998 dalam Jayanti, 2010). 

Hasil inventarisasi pada tahun 1999 setelah terjadinya kebakaran hutan tahun 

1997/1998 menunjukkan di areal tegakan hutan sekunder tua yang tidak terbakar, 

masih ditemukan sejumlah 650 pohon yang hidup dengan diameter di atas 10 cm 

dengan 116 jenis pohon.  Inventarisasi terbaru oleh APHI dari 150 Ha terdapat 

2.600 individu pohon hidup yang berdiameter > 50cm.  Namun banyak yang telah 

cacat.  Indonesia merupakan negara yang memiliki hutan hujan tropis terbesar 

kedua setelah Brazil yang mencakup sekitar 10% dari luasan hutan hujan tropis 

dunia.  Diperkirakan terdapat lebih dari 25.000 jenis flora dan baru 4.000 jenis 

yang telah diketahui penggunaannya baik sebagai penghasil kayu (sebagai bahan 

bangunan dan pertukangan) dan hasil lain yang dikenal sebagai hasil hutan bukan 

kayu (Anonim, 1998 dalam Jayanti, 2010). 

 

 

B. Hasil Penelitian 

Lokasi penelitian ini pada Zona Rekreasi, Zona Koleksi dan Zona Konservasi 

KRUS, dengan menggunakan metode transek dimana lokasi ketiga zona tersebut terbagi 

dalam tiga transek dengan panjang transek masing-masing 1.000 m dengan lebar 

masing-masing transek 20 meter.  Untuk luas lokasi penelitian dapat dilihat pada Tabel 

2.  

Tabel 2.  Panjang Transek, Lebar Transek dan Luas Plot Penelitian 
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Transek 

Panjang 

Transek 

(m) 

Lebar 

Transek 

(m) 

Luas Plot 

Penelitian 

(m²) 

Keterangan (m) 

A 1.000 20 20.000 

Zona Rekreasi (37 m) 

Zona Koleksi (638 m) dan 

Zona Konservasi ( 325 m) 

B 1.000 20 20.000 
Zona Koleksi (235 m) dan 

Zona Konservasi ( 765 m) 

C 1.000 20 20.000 

Zona Rekreasi (103 m) 

Zona Koleksi (247 m) dan 

Zona Konservasi ( 650 m) 

Total 60.000  

 
Dari Tabel 2 di atas dapat dilihat, Luas lokasi masing-masing transek yaitu seluas 

20.000 m² sehingga nilai luasan total lokasi penelitian adalah 60.000 m²    (6 ha) hanya 

mewakili 2 % dari luas KRUS keseluruhan.   

Berdasarkan hasil pengamatan pada 3 transek lokasi pengamatan  ditemukan 

pohon Ulin sebanyak 29 pohon. Jumlah individu di masing-masing transek dapat dilihat 

pada Tabel 3 sebagai berikut : 

 

Tabel 3.  Rekapitulasi Hasil Inventarisasi dari Tegakan Ulin Diameter ≥ 10 cm di  

Kebun Raya Unmul Samarinda (KRUS) Provinsi Kalimantan Timur 

No 

Transek 

No 

Pohon 

Ulin 

No 

PU 

Diameter 

(Ø) 

TBC 

(m) 

TTOT 

(m) 

VBC 

(m3) 

VTOT 

(m3) 

Titik Koordinat 

BT LS 

 

1 1 22.7 2.6 15.7 0.07 0.44 117° 12' 46.53" E 0° 26' 43.08" S 

2 7 38.2 5.8 12.5 0.46 1.00 117° 12' 49.49" E 0° 26' 42.91" S 

  3 8 39.2 11.0 20.3 0.92 1.71 117° 12' 50.20" E 0° 26' 42.90" S 

  4 9 27.4 9.9 18.4 0.40 0.75 117° 12' 50.50" E 0° 26' 42.93" S 

A 5 10 76 13.1 31.4 4.15 9.97 117° 12' 51.12" E 0° 26' 42.90" S 

  6 11 86.1 18.0 20.4 7.33 8.31 117° 12' 51.91" E 0° 26' 42.77" S 

  7 13 17.3 7.4 16.5 0.12 0.27 117° 12' 52.59" E 0° 26' 42.19" S 

  8 18 33.7 10.4 22.2 0.64 1.38 117° 12' 55.09" E 0° 26' 42.51" S 
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No 

Transek 

No 

Pohon 

Ulin 

No 

PU 

Diameter 

(Ø) 

TBC 

(m) 

TTOT 

(m) 

VBC 

(m3) 

VTOT 

(m3) 

Titik Koordinat 

BT LS 

  9 26 27.1 6.0 19.3 0.24 0.77 117° 12' 59.10" E 0° 26' 42.10" S 

  10 38 45.5 10.4 23.6 1.18 2.68 117° 13' 5.51" E 0° 26' 42.67" S 

JUMLAH VOLUME TRANSEK A 15.51 27.28 
 

 

  11 6 14.5 7.4 20.3 0.08 0.23 117° 12' 53.08" E 0° 26' 52.32" S 

  12 7 72.3 11.4 27.6 3.27 7.93 117° 12' 53.57" E 0° 26' 52.21" S 

  13 42 14.1 4.6 19.8 0.05 0.21 117° 13' 15.47" E 0° 26' 54.17" S 

 B 14 42 12.6 5.8 14.4 0.05 0.12 117° 13' 15.66" E 0° 26' 54.21" S 

 
15 44 39.2 7.7 22.1 0.65 1.86 117° 13' 16.76" E 0° 26' 54.17" S 

  16 45 32.2 7.5 21.5 0.42 1.22 117° 13' 17.38" E 0° 26' 54.50" S 

  17 46 34.5 10.5 17.6 0.68 1.15 117° 13' 17.73" E 0° 26' 54.63" S 

Lanjutan Tabel 3. 

No 

Transek 

No 

Pohon 

Ulin 

No 

PU 

Diameter 

(Ø) 

TBC 

(m) 

TTOT 

(m) 

VBC 

(m3) 

VTO

T (m3) 

Titik Koordinat 

BT LS 

  
B 

18 46 20.6 10.6 24.2 0.24 0.56 117° 13' 17.93" E 0° 26' 54.17" S 

19 46 66.8 14.3 27.2 3.50 6.67 117° 13' 17.93" E 0° 26' 54.17" S 

  20 46 27 8.4 21.8 0.33 0.87 117° 13' 17.89" E 0° 26' 54.11" S 

JUMLAH VOLUME TRANSEK B 

9.27 20.82 
 

 

  21 1 11.3 3.3 6.3 0.02 0.04 

117° 12' 42.60" E 0° 26' 57.37" S 

  22 1 24.1 7.1 19.1 0.22 0.60 

117° 12' 42.60" E 0° 26' 57.37" S 

  23 1 25.8 6.1 20.0 0.22 0.73 

117° 12' 42.60" E 0° 26' 57.37" S 
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No 

Transek 

No 

Pohon 

Ulin 

No 

PU 

Diameter 

(Ø) 

TBC 

(m) 

TTOT 

(m) 

VBC 

(m3) 

VTO

T (m3) 

Titik Koordinat 

BT LS 

C 24 4 25.8 5.8 17.1 0.21 0.62 

117° 12' 44.73" E 0° 26' 57.43" S 

  25 4 15.5 4.6 13.1 0.06 0.17 

117° 12' 44.94" E 0° 26' 57.69" S 

  26 24 24.2 7.0 16.6 0.22 0.53 

117° 12' 57.71" E 0° 26' 57.71" S 

  27 32 26.2 8.0 23.0 0.30 0.86 

117° 13' 2.82" E 0° 26' 57.94" S 

 

28 37 21.8 4.6 17.4 0.12 0.45 

117° 13' 6.41" E 0° 26' 58.18" S 

29 38 55.2 9.0 22.5 1.50 3.76 

117° 13' 7.08" E 0° 26' 58.07" S 

JUMLAH VOLUME TRANSEK C 

2.87 7.76 

 
 

JUMLAH VOLUME TRANSEK A + B + C 27.65 55.86 
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V. PEMBAHASAN 

A. Potensi Ulin 

Plot penelitian dengan menggunakan metode transek yang  terbagi dalam   

3 transek dengan panjang transek 1.000 m . Untuk lebar masing-masing transek   

20 meter. Penelitian ini menggunakan metode transek dimana transek tersebut 

memotong kontur sehingga dapat mewakili masing-masing kontur KRUS, 

masing-masing transek memotong kontur dengan arah kompas 90°. Arah kompas 

masih mempertimbangkan anakan-anakan yang ada. 

Kondisi transek A sangat bervariasi, ada banyak bukit dan banyak 

lembahnya, jika dibanding dengan transek B dan C dimana transek B dan C relatif 

banyak terdapat daerah landai. Namun untuk kondisi keadaan hutannya kondisi 

transek A lebih baik dibanding dengan transek B dan transek C. Kondisi transek A 

dan B memiliki tutupan lahan yang cukup baik namun ada perbedaan diantara 

transek A dan B,  transek A terdapat jenis yang cukup beragam baik jenis kayu 

dan buah sedangkan transek B lebih banyak didominasi jenis buah dan jenis pionir 

yaitu jenis mahang (Macaranga).  Sedangkan kondisi transek C adalah kondisi 

yang lebih terbuka dibanding transek yang lain, kondisi pada transek ini melewati 

jalur penanaman dan kebun aren. Pada jalur C juga ada bagian yang tutupan 

lahannya cukup baik setelah melewati kebun aren namun jenisnya tidak banyak 

hanya mahang. 

 

Pada transek A diameter paling besar adalah 86,1 cm dengan volume total 

sebesar 8,31 m³ sedangkan diameter paling kecil adalah 17,3 cm dengan volume 

total sebesar 0,27 m³. Pada transek B diameter paling besar adalah 72,3 cm 

dengan volume total sebesar 7,93 m³ sedangkan diameter paling kecil adalah    

12,6 cm dengan volume total sebesar 0,12 m³. Sedangkan pada transek C 

ditemukan diameter paling besar adalah 55,2 cm dengan volume total sebesar   

3,76 m³ sedangkan diameter paling kecil adalah 11,3 cm dengan volume total 

sebesar 0,04 m³.  Dari hasil penelitian dapat dilihat diameter yang paling besar 

adalah 86,1 cm dengan volume total sebesar 8,31 m³ yang ditemukan pada transek 

A sedangkan diameter yang paling kecil adalah 11,3 cm dengan volume total 

sebesar 0,04 m³ yang ditemukan pada transek C.  

Jika dilihat dari volume total (V Tot) yang paling besar ditemukan pada 

pohon 5 (diameter = 76 cm, V Tot = 9,97 m³) dibandingkan dengan pohon 6 

(diameter = 86,1 cm, V Tot = 8,31 m³), hal ini kemungkinan dikarenakan pohon 6 

memiliki cacat pada batangnya sehingga pohon 5 yang memiliki diameter lebih 

kecil memiliki V Tot yang lebih besar. Diantara semua pohon yang ditemukan, 

kedua pohon Ulin tersebut memiliki volume terbesar yang ditemukan di transek A 

yaitu pada zona pengayaan/koleksi, hal ini dimungkinkan karena pada lokasi 

tersebut topografi cenderung datar dan bukanlah habitat rawa.  
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Pada umumnya ditemukan anakan-anakan disekitar pohon Ulin.  Menurut 

pekerja KRUS hal ini dikarenakan karena kurangnya pemangsa biji Ulin seperti 

trenggiling, sehingga biji Ulin di KRUS dapat tumbuh dengan baik. Ini 

merupakan pertanda yang baik untuk melakukan kegiatan pelestarian pohon Ulin 

karena dalam membudidayakannya, masalah anakan Ulin sedikit teratasi.  

Menurut Anonim
c
 (2012)  proses pemuliaan alami di hutan bekas tebangan 

umumnya kurang berjalan dengan baik.  Perkecambahan biji Ulin membutuhkan 

waktu cukup lama yaitu sekitar 6 – 12 bulan dengan persentase keberhasilan 

relatif rendah, produksi buah tiap pohon umumnya juga sedikit. Penyebaran 

permudaan alam secara umum cenderung mengelompok.  Ulin tumbuh di dataran 

rendah  primer dan hutan sekunder sampai dengan ketinggian 500 m dpl.  Biji 

Ulin lebih suka ditiriskan baik pada tanah, tanah liat berpasir ke tanah liat, 

kadang-kadang batu kapur.  Hal ini umumnya ditemukan di sepanjang sungai dan 

bukit-bukit yang berdekatan. 

Menurut Anonim
a
 (2010) meskipun Ulin menyukai udara lembab namun 

Ulin bisa tumbuh di daerah kering.  Hingga umur 3 tahun, Ulin tidak butuh 

banyak cahaya.  Setelah itu sedikit demi sedikit membutuhkan cahaya penuh. 

Anakan-anakan yang ditemukan di plot penelitian yaitu berupa anakan 

seperti semai dan ada pula tunas yang baru tumbuh pada biji-biji Ulin yang 

berjatuhan seperti dapat terlihat dari Gambar 4 berikut ini: 

 
Pancang Pohon Ulin 

 
Biji Pohon Ulin 

Gambar 4. Anakan Pohon Ulin 

 

Pohon Ulin merupakan salah satu dari kelompok kayu indah dimana kayu 

Ulin adalah kayu yang sangat berat dan paling awet di dunia. Kayu ini termasuk 

ke dalam kelompok kelas awet I, sehingga pohon ini telah banyak tereksploitasi 

secara berlebihan.  Selain itu jenis Ulin juga terancam punah karena proses 

pengembangbiakannya juga yang sangat sulit dan rendahnya generasi.  Sehingga 

potensi Ulin yang dimiliki negara kita pun secara otomatis berkurang drastis pula. 



24 
 

 

Berdasarkan data IUCN (2000) dalam Anonim
b
 (2010), jenis ini dikategorikan 

dalam kelompok yang rentan (vulnerable) yaitu populasi mengalami penurunan 

lebih dari 20% selama 10 tahun. Penyebab utama keterancaman kepunahan adalah 

karena kerusakan habitat dan pemanfaatan yang tidak terkendali (Nugroho, 2010 

dalam Anonim
b
, 2010). 

 Adapun potensi pohon Ulin dapat dilihat dari jumlah volume tinggi bebas 

cabang (V TBC) pohon Ulin yang ditemukan di lokasi pengamatan seluas 6 Ha 

adalah sebesar 27,65 m³ sedangkan volume total (V Tot) adalah sebesar 55,86 m³. 

Besarnya diameter pohon dengan volume adalah cenderung berbanding lurus, 

untuk mengetahui hubungan antara diameter (cm) dengan volume (m³) dapat 

dilihat pada Gambar 5 dan Gambar 6 berikut ini : 

 
Gambar 5. Hubungan antara Diameter dan Volume Tinggi Bebas Cabang          

pada Plot Penelitian Seluas 6 Ha 

 

 
Gambar 6. Hubungan antara Diameter dan Volume Total pada Plot Penelitian 

Seluas 6 Ha  
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Dari grafik diatas dapat dilihat bahwa pohon Ulin dengan diameter 10 – 40 

cm lebih banyak dibandingkan dengan kelompok diameter lainnya. Hal ini 

disebabkan hutan di KRUS merupakan hutan sekunder muda yang pernah 

mengalami kebakaran yang disebabkan oleh kandungan batu bara yang terbakar, 

pada ketiga jalur tersebut terdapat banyak pohon Ulin yang sudah mati dan 

tumbang. Pohon Ulin yang sudah mati dan sudah tumbang tersebut  juga 

terkadang dimanfaatkan untuk perbaikan fasilitas yang ada di KRUS. Sehingga 

pohon-pohon ulin yang tumbuh di KRUS merupakan pohon-pohon muda, selain 

itu pertumbuhan pohon ulin tergolong lambat. Dalam satu tahun, diameter pohon 

Ulin kurang dari 1 cm, pada usia 40 tahun diameter Ulin mencapai 36 cm, baru 

pada umur 100 tahun diameter ulin bisa 50 cm (Anonim
a
, 2011). 

 
Gambar 7. Batang pohon tumbang sisa Kebakaran Tahun 1997/1998  
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Gambar 8. Batang-batang pohon sisa Kebakaran Tahun 1997/1998  

 

B. Sebaran Pohon Ulin 

Pada setiap transek penelitian berada pada dua atau tiga zonasi sehingga 

sebaran pohon Ulin dapat digambarkan berdasarkan transek dan juga berdasarkan 

zonasi.  

Pada transek A dan B ditemukan pohon Ulin masing-masing sebanyak      

10 pohon Ulin sedangkan pada transek C ditemukan 9 pohon Ulin, sehingga total 

dari ketiga transek tersebut ditemukan 29 pohon. Untuk kehadiran jumlah 

individu pohon Ulin pada masing-masing transek dapat dilihat pada Gambar 9 di 

bawah: 

 
Gambar 9. Jumlah Pohon Ulin pada Plot Pengamatan setiap Transek 
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Secara keseluruhan transek plot penelitian ini berada pada 3 zona yaitu 

zona rekreasi, zona koleksi/pengayaan dan zona konservasi. Satu transek bisa 

berada pada 2 zonasi ataupun 3 zonasi. Jumlah total pohon Ulin pada zona 

rekreasi yang seluas 0,28 Ha sebanyak 8 pohon, pada zona koleksi/pengayaan 

sepanjang 2,24 Ha seluas 10 pohon dan zona konservasi seluas 3,48 Ha sebanyak 

11 pohon. Untuk kehadiran jumlah individu pohon Ulin pada masing-masing zona 

dapat dilihat pada Gambar 10 di bawah: 

 
Gambar 10. Jumlah Pohon Ulin pada Plot Pengamatan berdasarkan Zonasi 

Kehadiran sebaran pohon Ulin di plot penelitian tersebut perlu untuk 

dipetakan sebarannya sehingga menjadi dasar bagi pengelola KRUS dalam 

melaksanakan kebijakan khususnya yang berkaitan dengan keberadaan pohon 

Ulin.  
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Gambar 11. Pohon Ulin pada Plot Penelitian 
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VI. KESIMPULAN DAN SARAN 

A. Kesimpulan 

Berdasarkan hasil penelitian inventarisasi dan pemetaan pohon Ulin 

(Eusideroxylon zwageri Teijsm. & Binn.) di Kebun Raya Unmul Samarinda 

(KRUS)  dapat disimpulkan sebagai berikut: 

1. Diameter pohon Ulin yang paling besar adalah 86,1 cm dengan volume total 

sebesar 8,31 m³ yang ditemukan pada transek A sedangkan diameter yang 

paling kecil adalah 11,3 cm dengan volume total sebesar 0,04 m³ yang 

ditemukan pada transek C. Adapun potensi pohon Ulin dapat dilihat dari 

jumlah volume tinggi bebas cabang (V TBC) pohon Ulin yang ditemukan di 

lokasi pengamatan seluas 6 Ha adalah sebesar 27,65 m³ sedangkan volume 

total (V Tot) adalah sebesar 55,86 m³. 

2. Sebaran pohon Ulin di KRUS ditemukan zona konservasi seluas 3,48 Ha 

sebanyak 11 pohon, pada zona koleksi/pengayaan sepanjang 2,24 Ha seluas 

10 pohon dan pada zona rekreasi seluas 0,28 Ha sebanyak 8 pohon.  

 

B. Saran 

Dari hasil penelitian dapat disampaikan saran sebagai berikut: 

1. Agar pihak KRUS berusaha tetap menjaga keberadaan dan kelestarian pohon Ulin 

yang sudah ada di KRUS dari gangguan kebakaran hutan.  

2. Perlu dilakukan inventarisasi pohon Ulin pada seluruh kawasan KRUS ntuk 

mengetahui sebaran dan potensi pohon Ulin. 
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3. Perlu dilaksanakan penanaman pohon Ulin untuk meningkatkan jumlah keberadaan 

pohon Ulin di KRUS dan juga menjaga dan mengurus anakan-anakan pohon Ulin 

yang masih ada. 
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